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In the Curriculum

Language Learning

This is the second article in a two-part series that demonstrates how productivity software

can be used to motivate beginning middle school foreign-language students (or elementary-

level foreign-language immersion students). The exercises in Part I featured in the May

1997 issue of L&L used word processing tools to increase language fluency, spelling, and

agreement skills. The second article features language-learning exercises for the spreadsheet,

database, and mail -merge functions of popular productivity software packages.

Spreadsheets, Databases, & Mail Merge
Using Productivity Software for Beginning Language Learning • Part II
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By Pam Lewis

When teaching or learning a second language, finding ways to
practice verb conjugations in written form is always a challenge.
Understanding how the conjugations are formed and having an
awareness of any patterns in the conjugation help students
memorize the written forms of verbs. Databases, mail-merge
features, and spreadsheets can be applied in amazing ways to
teach foreign language—especially in writing.

In the assignments featured in this article, students create
a database of verb conjugations, a spreadsheet for conjugat-
ing verbs, and a database and word processing document
that use the mail-merge feature to create documents that
automatically generate the correct conjugation for the cor-
rect gender and number.

Although I used these assignments with seventh- and
-eighth grade French students, they could be applied to teach-
ing other languages. Immersion students could use these
activities in upper elementary school, and adult or high school
learners would also benefit from these exercises.

Using a Database to Record Verb Conjugations
In addition to more written practice with verbs, the process
of entering the verbs into a database and then manipulating
the records helps students concentrate on the patterns in the
conjugations and focuses their attention on what is irregular
about certain verbs. These activities are appropriate as soon
as students have mastered pronunciation, meaning, and the
use of pronouns through modeling, repetition, and ques-
tion-and-answer exercises.

Students should first write out the verbs, paying careful
attention to spelling for each conjugated form. In my
precomputer years, I had students write out the verbs in col-
umns, which helped them sort the verbs according to type
and made them easier to memorize. Now we can take it a
step further through the use of the database of verbs and
their conjugations. For example, if you have already created
your own database of verbs, it is easy to use it to generate
homework assignments by copying and pasting the verbs
from the database into a spreadsheet file and deleting cer-
tain words to make blanks that students can fill in.

Database Basics. To introduce the database activities, dis-
cuss with students the general uses of a database, such as for
storing and organizing data in a phone book, dictionary, or
the like. Ask students to suggest ways in which a database
could be used for verbs.

Have students write out the conjugations of 10 verbs on
flash cards. Next have them organize the cards in various
ways: alphabetically, by verb type, and by endings for a cer-
tain pronoun. Help students develop their own explanations
for why we group the verbs as we do (regular according to
certain patterns and irregular because of some exception to

the established pattern). Have students identify whether there
are any patterns among the irregular verbs.

Creating the Database. Students then create a database file
and enter the data as they conjugate the verbs. Students can
use the instructions from the Verb Conjugation Exercise
Using ClarisWorks Databases exercise shown on page 15.
You can adapt most of the instructions to work with any
other database program, such as Microsoft Works. The
sample database shown in Figure 1 was created by a seventh-
grade student taking French 1 shortly after the concept of
verb conjugation was introduced. This student database
consists mainly of verbs ending in -er and a few irregular
verbs. Students in that class added new records to this verb
database as they learned new conjugations over the course of
the school year.

In the Curriculum

Figure 1 shows a verb conjugation spreadsheet created by a first-year middle-
school French student. It includes numerous regular verbs and a few irregular
verbs.

Manipulating the Data. After the initial group of verbs is
entered, students can manipulate the database in the same
way they did the flash cards. I required my eighth-grade stu-
dents to enter all the verbs they had learned so far. They
worked at their own pace, and most of them completed the
assignment within the time alotted, defining the fields and
entering all their verbs in the database. Some students also
had time to complete the follow-up questions on the
worksheet, doing the record selections and explaining how
verbs can be grouped according to patterns in their endings.

Using Spreadsheets to Conjugate Verbs
Spreadsheets are also powerful tools to use when reviewing
verbs. The spreadsheet draws attention to how verbs are cat-
egorized and how the conjugation of regular verbs is
generated. Once the spreadsheet is set up, all the user must
do to enter a new regular verb is type in the infinitive and
the stem and then use Fill Right to complete the automatic
conjugation.

Spreadsheet Basics. Begin this lesson with a review of what a
spreadsheet is and how it can be used to organize data in
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categories. Explain how formulas can be used to do math-
ematical calculations on the spreadsheet. Have students
brainstorm how this can be applied to studying verb conju-
gations.

Explain how the LEN, RIGHT, LEFT, and CONCAT
functions work with text (if you are unfamiliar with these
commands, consult the spreadsheet section of the manual
for the software package you are using). Discuss how you
could use these functions to determine the infinitive end-
ing, stem, and conjugation. Have students discuss what other
information they might need, such as the number of letters
in the stem as well as the  appropriate endings for each per-
sonal pronoun.

Creating the Spreadsheet. Students then create a spreadsheet
using the worksheet entitled Verb Exercises Using Spread-
sheets in ClarisWorks on page 16. Remind students that it is
important to hit Tab or Enter before they move to another
cell when entering a formula. To save time, you can provide
your students with a spreadsheet template with the headings
already entered.

Follow-Up Activities. Have students see if they can extend
the spreadsheet to create the compound past tense (passé
composé) for each of the verbs entered. They will need to
add the ending for the stem that forms the past participle
and devise a formula to form the past participle using
CONCAT. Then they will need to add the personal pro-
noun and appropriate conjugation of avoir or être (j’ai, tu
as, il a, etc.), plus a space. Next they must devise the formula
to join the past participle to the appropriate conjugation.

Other tenses could be added in similar fashion as they are
introduced in class. Irregular verbs might cause a problem;
there may be two stems, or the verb may not follow any
pattern at all. Students could be instructed to Fill Right for
all verbs, including irregular verbs, and then go back and
correct “mistakes” made by the computer.

Using Mail Merge to Conjugate Verbs Automatically
After students have learned word processing features and
completed a database of verb conjugations, they are ready
for this exercise. Begin by discussing the mail-merge feature
and the kind of things it can be used for, such as form letters
used by a school or bank.

Creating a Mail-Merge Document. Ask students to think of
ways their verb databases could be used in a mail-merge docu-
ment. Demonstrate to the class that if each verb was a new
record and the fields were the subjects (first person singular,
second person singular, etc.), we would get several copies of
our description, each using different verbs. In order to have
our mail-merge document conjugate different verbs, we
would need to create a new database for each subject pro-
noun, with the field data being the conjugated form of each
verb we wanted to use in the document. Have students com-
plete the Descriptive Paragraph Using Mail Merge assignment
on page 17. As soon as students have finished creating their
documents, let them illustrate their descriptions using their
own graphics or clip art. ■

Pam Lewis, 8560 N. Point Drive, Fox Point, WI 53217;
pamlewis@execpc.com

Shareware Databases
The author has created shareware databases in French (Span-
ish and German to be completed soon) using ClarisWorks
and Microsoft Works on both Macintosh and PC platforms.
Teachers can use the databases to generate exercises or tests,
they can use them in the computer lab with students and
teach them how manipulate or add to the files, or they can
use the verbs in a mail-merge document. In addition, she
has included disk copies of all assignments mentioned in
this article. For more information, contact the author at the
e-mail address above.

In the Curriculum
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1. Each student team should create a New database file
entitled “Révision de Verbes” and enter  the following field
names into the Define Fields window (see illustration):
infinitif, en anglais, je, tu, il/elle, nous, vous, ils/elles, futur
proche (je), passé composé (il).

2. Enter the following verbs as you conjugate them:
aller, être, avoir, regarder, écouter, danser, donner, chanter,
étudier, travailler, parler, manger,  habiter, détester, adorer,
arriver, rentrer, demander, tomber, acheter, manger,
applaudir, rougir, dormir, servir, sortir, attendre, vendre,
apprendre, comprendre (30 verbs total)

3. Sort the verbs:
• Into alphabetical order.
• By their endings—er, ir, and irregular. To select certain

records, such as verbs ending in “er,” select Match
Record and type in: right('infinitif',2)="er". This tells the
sorting function to sort out infinitives whose last two
letters equal “er.”

4. Change the layout of your document:
• Under Layout, pull down New Layout. Click the button

for Columnar Report.
• Under File, pull down Page Setup. Change the orientation

of the paper to landscape.
• Under the Layout menu, select the Layout view. Adjust

spacing of columns and formatting to produce a page
that allows you to read all of the verbs and their
conjugations easily.

• Return to the Browse view by reselecting it in the Layout
menu.

In the Curriculum

Verb Conjugation Exercise Using ClarisWorks Databases

5. Save and print one copy for each member of your
group to use as a study guide.

6. Answer the following questions:
1. How many “je” conjugations end in -s? What type of

verbs are these?
2. What do the endings of all “tu” conjugations have in

common?
3. How many “nous” conjugations end in -ons? Which

“nous” conjugations end in -issons? Which “nous”
conjugations do not end in -ons?

4. What do the “vous” conjugations (-ez or -es) have in
common?

5. Which “ils/elles” conjugations end in -ont? What do
the endings of  all other “ils/elles” conjugations have
in common?

7. Complete this sentence: Grouping verbs makes it easier
to learn their conjugations because ...

The Define Database Fields dialog box in ClarisWorks.

A N  I S T E  C O P Y - M E  P A G E
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1. Create a spreadsheet entitled “Révision de Verbes” with
the following headings in the first row: infinitif, regarder,
parler, jouer, monter, montrer, attraper, finir, saisir, punir,
and attendre so that it resembles row 1 on the sample
spreadsheet shown.

2. In the first column under the cell with “infinitif,” enter the
following cell names: # of chars, type, stem 1, and stem 2
so that it resembles column A in the sample spreadsheet
shown.

3. To count the number of letters in each verb and enter that
number in row 2, paste in the function LEN(text) or type in
LEN(B1). This counts the number of characters in that cell.
Highlight the rest of the cells in the row after column B,
and use the Fill Right Command to copy the formula into
the rest of the cells in that row.

4. For the present-tense conjugations, skip the cell under
“stem 2,” and enter the following in each cell in column A:
Present Tense, endings, je, tu, il/ elle/on, nous, vous, ils/
elles, then skip a cell and enter je, tu, il/elle/on, nous, vous,
and ils/elles.

5. To determine the verb type (-er, -ir, or -re verb), enter the
formula =RIGHT(B1,2) into cell B3 so that the spreadsheet
will determine the last two letters at the end of the verb
and enter it into the cell. Hit the Return key when you are
finished creating the formula. Highlight the rest of the cells
in the row after column B, and use the Fill Right command
to copy the formula into the rest of the cells in that row.
After you are done with the Fill Right command, all of the
verb types should be listed in the proper cells.

6. To determine the stem of the verb, enter the formula
=LEFT(B1,(B2–2)) as shown in the following illustration. Hit
Return, and select the rest of the cells in that row. Use Fill
Right to copy the formula into the rest of the row. When
you are done, your spreadsheet should have each verb
stem listed.

7. Enter the appropriate verb endings for the present tense
in B9–B14. Copy and paste for other verbs of the same
type. Do the same for the -ir and -re verbs.

8. To begin filling in the conjugations for the first verb (B16–
B21), enter the formula =CONCAT(B4, B9) in B16 to form the
conjugation for “je,” first person singular. B4 (the stem) and B9
(the ending) are joined together. For cells B17–B21, B4 remains
in the formula as the stem, but cell B9 needs to change to
whatever cell contains the corresponding ending (B10–B14)
for that particular subject (“tu”, il/elle/on, etc.).

9. Use Fill Right to copy each formula across the row for each
personal pronoun (“je”, “tu”, etc.). When you are finished,
you should see each verb conjugated across the
spreadsheet as shown here:

In the Curriculum

Verb Exercises Using Spreadsheets in ClarisWorks

The LEFT(B1,(B2-2)) formula drops the final two letters of the infinitive to

calculate the stem of the verb.

After entering the formula to combine the verb stem with the proper
verb ending for each person/gender, use the Fill Right command to
conjugate all the verbs in the remainder of the database.

10. Voilà! You have conjugated 10 regular verbs of three different
types. Format the text and column and row sizes as you wish,
and print your spreadsheet to keep as a study aid.

A N  I S T E  C O P Y - M E  P A G E
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1. What can mail merge be used for?

2. What documents must be open to be able to do a mail
merge?

Here are the steps for conjugating verbs in the first- and
third-person singular and inserting them into a descriptive
paragraph:

1. Open a new database document.
• When the Define Database Field window appears, enter

the names of all the infinitives you plan to use in your
paragraph as separate field names. The following verbs
may be included:
s’appeler
avoir (ans)
habiter
aller
manger
faire
adorer
parler
être
passer
porter
aimer
regarder

• Save the database as “Verb database—je”.
• Under the Format menu, select Insert Header. Enter the

name “Verb database—je” as your header, along with
the name of your group and the date.

• Under the View pull-down menu, select Tile Windows.
• Pull down the Layout menu and select Browse. Enter the

correct form of each of those verbs for je (first-person
singular). You may choose to copy and paste this
information from the spreadsheet you have already
completed. Save the database.

2. Open a new Word Processing document.
• Save it as “Moi.”
• Write two paragraphs in French describing yourself. Give

information about your age, your personality, where you
live, the school you go to, what you like to do, what you
do after school or on weekends, and the languages you
speak. Use at least five of the verbs from your database.
Do not conjugate any verbs you use in this rough draft;
instead mark the place where you will later insert the
correct form of the verb by entering the infinitive form
in bold face.

• Save.

Creating a Descriptive Paragraph  Using Mail Merge in ClarisWorks 4.0
In the Curriculum

3. With both the database and word processing documents
open, go to the View menu and  select Tile Windows. You
should be able to see both the word processing document
and the database. Highlight the first infinitive you need to
replace with a conjugated verb. Select the Mail Merge
function under the file menu and the following dialog box
will appear.

In the Field Name column, select the verb you want to
conjugate, click on it, and click on Insert Field. It will place
the infinitive in angle brackets in your document, so that it
looks like the following:
Je <<s’appeler>> Dana.

4. Continue using the mail-merge function to insert the verbs
you need until your description is complete.  Click on Print
Merge in the Mail Merge dialog box. You will then see the
standard print menu. Make whatever adjustments are
necessary to the print information and then click on Print.

Note: You may not use different forms of the verb (tu, il/
elle, nous, vous, ils/elles) with the mail-merge function in
this document. If you use a different subject with a verb,
you must conjugate that verb yourself.

5. Now do a description of your mother or a female friend.
Repeat the steps above, except this time create and open
an "elle verbs" database. You can easily adapt the “je verbs”
database and then save it as “elle verbs” if you wish. Create
a mail-merge document similar to the one you have already
created. Print this document with all the correct forms of
the verbs for third-person singular by clicking on Print
Merge.

The Mail Merge Dialog box in ClarisWorks.

A N  I S T E  C O P Y - M E  P A G E
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